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Introduction

LVhat’s your story?

v Are you a working stiff, interested in knowing more about the way your
company’s computers work?

v Are you a student who needs some extra reading in order to survive a
beginning computer course?

v Are you a typical computer user — you've done lots of word processing,
and you want to do something more interesting with your computer?

v Are you a job seeker with an interest in entering the fast-paced, glamor-
ous, high-profile world of computer programming (or, at least, the decent-
paying world of computer programming)?

Well, if you want to write computer programs, this book is for you. This book
avoids the snobby “of-course-you-already-know” assumptions and describes
computer programming from scratch.

About This Book

The book uses Java — a powerful, general-purpose computer programming
language. But Java’s subtleties and eccentricities aren’t the book’s main focus.
Instead, this book emphasizes a process — the process of creating instruc-
tions for a computer to follow. Many highfalutin’ books describe the mechan-
ics of this process — the rules, the conventions, and the formalisms. But those
other books aren’t written for real people. Those books don’t take you from
where you are to where you want to be.

In this book, [ assume very little about your experience with computers. As
you read each section, you get to see inside my head. You see the problems
that I face, the things that I think, and the solutions that I find. Some problems
are the kind that [ remember facing when [ was a novice; other problems are
the kind that I face as an expert. | help you understand, I help you visualize,
and [ help you create solutions on your own. I even get to tell a few funny
stories.
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How to Use This Book

[ wish I could say, “Open to a random page of this book and start writing Java
code. Just fill in the blanks and don’t look back.” In a sense, this is true. You
can’t break anything by writing Java code, so you're always free to experiment.

But I have to be honest. If you don’t understand the bigger picture, writing a pro-
gram is difficult. That’s true with any computer programming language — not
just Java. If you’re typing code without knowing what it’s about, and the code
doesn’t do exactly what you want it to do, then you're just plain stuck.

So in this book, I divide programming into manageable chunks. Each chunk

is (more or less) a chapter. You can jump in anywhere you want — Chapter 5,
Chapter 10, or wherever. You can even start by poking around in the middle
of a chapter. I've tried to make the examples interesting without making one
chapter depend on another. When I use an important idea from another chap-
ter, I include a note to help you find your way around.

In general, my advice is as follows:

v 1If you already know something, don’t bother reading about it.

v If you're curious, don’t be afraid to skip ahead. You can always sneak a
peek at an earlier chapter if you really need to do so.

Conventions Used in This Book

Almost every technical book starts with a little typeface legend, and Beginning
Programming with Java For Dummies, 4th Edition is no exception. What follows
is a brief explanation of the typefaces used in this book:

1 New terms are set in italics.

v When [ want you to type something short or perform a step, I use bold.

v You'll also see this computerese font. I use the computerese font for
Java code, filenames, web page addresses (URLs), onscreen messages,
and other such things. Also, if something you need to type is really long,
it appears in computerese font on its own line (or lines).

» You need to change certain things when you type them on your own
computer keyboard. For example, I may ask you to type

class Anyname
which means you should type class and then some name that you make

up on your own. Words that you need to replace with your own words
aresetin italicized computerese.
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What You Don’t Have to Read

Pick the first chapter or section that has material you don’t already know and
start reading there. Of course, you may hate making decisions as much as
I do. If so, here are some guidelines you can follow:

v If you already know what computer programming is all about, skip the
first half of Chapter 1. Believe me, I won’t mind.

v If you're required to use a development environment other than Eclipse,
you can skip Chapter 2. This applies if you plan to use NetBeans, IntelliJ
IDEA, or a number of other development environments.

Most of this book’s examples require Java 5.0 or later, and some of the
examples require Java 7 or later. So make sure that your system uses
Java 7 or later. If you're not sure about your computer’s Java version or
if you have leeway in choosing a development environment, your safest
move is to read Chapter 3.

v If you've already done a little computer programming, be prepared to
skim Chapters 6 through 8. Dive fully into Chapter 9 and see whether it
feels comfortable. (If so, then read on. If not, re-skim Chapters 6, 7, and 8.)

v If you feel comfortable writing programs in a language other than Java,
this book isn’t for you. Keep this book as a memento and buy my Java
For Dummies, 6th Edition, also published by John Wiley & Sons, Inc.

If you want to skip the sidebars and the Technical Stuff icons, please do. In
fact, if you want to skip anything at all, feel free.

Foolish Assumptions

In this book, I make a few assumptions about you, the reader. If one of these
assumptions is incorrect, you're probably okay. If all these assumptions are
incorrect . . . well, buy the book anyway.

v~ I assume that you have access to a computer. Here’s good news. You
can run the code in this book on almost any computer. The only comput-
ers you can’t use to run this code are ancient things that are more than
eight years old (give or take a few years). You can run the latest version
of Java on Windows, Macintosh, and Linux computers.

v 1 assume that you can navigate through your computer’s common
menus and dialog boxes. You don’t have to be a Windows, Linux, or
Macintosh power user, but you should be able to start a program, find a
file, put a file into a certain directory . . . that sort of thing. Most of the
time, when you practice the stuff in this book, you're typing code on
your keyboard, not pointing and clicking your mouse.
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On those rare occasions when you need to drag and drop, cut and paste,
or plug and play, I guide you carefully through the steps. But your com-
puter may be configured in any of several billion ways, and my instruc-
tions may not quite fit your special situation. So when you reach one of
these platform-specific tasks, try following the steps in this book. If the
steps don’t quite fit, send me an e-mail message, or consult a book with
instructions tailored to your system.

v 1 assume that you can think logically. That’s all there is to computer
programming — thinking logically. If you can think logically, you've got it
made. If you don’t believe that you can think logically, read on. You may
be pleasantly surprised.

v~ 1 assume that you know little or nothing about computer programming.
This isn’t one of those “all things to all people” books. I don’t please the
novice while I tease the expert. [ aim this book specifically toward the
novice — the person who has never programmed a computer or has never
felt comfortable programming a computer. If you're one of these people,
you’re reading the right book.

How This Book Is Organized

This book is divided into subsections, which are grouped into sections, which
come together to make chapters, which are lumped finally into five parts.
(When you write a book, you get to know your book’s structure pretty well.
After months of writing, you find yourself dreaming in sections and chapters
when you go to bed at night.) The parts of the book are listed here.

Part I: Getting Started with
Java Programming

The chapters in Part I prepare you for the overall programming experience.
In these chapters, you find out what programming is all about and get your
computer ready for writing and testing programs.

Part 1l: Writing Your Own Java Programs

This part covers the basic building blocks — the elements in any Java pro-
gram and in any program written using a Java-like language. In this part, you
discover how to represent data and how to get new values from existing
values. The program examples are short, but cute.
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Part 111: Controlling the Flow

Part Il has some of my favorite chapters. In these chapters, you make the
computer navigate from one part of your program to another. Think of your
program as a big mansion, with the computer moving from room to room.
Sometimes the computer chooses between two or more hallways, and some-
times the computer revisits rooms. As a programmer, your job is to plan the
computer’s rounds through the mansion. It’s great fun.

Part IU: Using Program Units

Have you ever solved a big problem by breaking it into smaller, more manage-
able pieces? That’s exactly what you do in Part IV of this book. You discover
the best ways to break programming problems into pieces and to create solu-
tions for the newly found pieces. You also find out how to use other peoples’
solutions. It feels like stealing, but it’s not.

This part also contains a chapter about programming with windows, buttons,
and other graphical items. If your mouse feels ignored by the examples in this
book, read Chapter 20.

Part U: The Part of Tens

The Part of Tens is a little beginning programmer’s candy store. In the Part of
Tens, you can find lists — lists of tips, resources, and all kinds of interesting
goodies.

I added an article at www . dummies.com/extras/beginningprogramming
withjava to help you feel comfortable with Java’s documentation. I can’t write
programs without my Java programming documentation. In fact, no Java pro-
grammer can write programs without those all-important docs. These docs are
in web page format, so they’re easy to find and easy to navigate. But if you're
not used to all the terminology, the documentation can be overwhelming.

lcons Used in This Book

If you could watch me write this book, you'd see me sitting at my computer,
talking to myself. I say each sentence several times in my head. When I have
an extra thought, a side comment, something that doesn’t belong in the regu-
lar stream, [ twist my head a little bit. That way, whoever’s listening to me
(usually nobody) knows that I'm off on a momentary tangent.


http://www.dummies.com/extras/beginningprogrammingwithjava
http://www.dummies.com/extras/beginningprogrammingwithjava
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Of course, in print, you can’t see me twisting my head. I need some other way
of setting a side thought in a corner by itself. I do it with icons. When you see
a Tip icon or a Remember icon, you know that I'm taking a quick detour.

Here’s a list of icons that I use in this book:

A tip is an extra piece of information — something helpful that the other books
may forget to tell you.

Everyone makes mistakes. Heaven knows that 've made a few in my time.
Anyway, when I think of a mistake that people are especially prone to make,
[ write about the mistake in a Warning icon.

Sometimes [ want to hire a skywriting airplane crew. “Barry,” says the white
smoky cloud, “if you want to compare two numbers, use the double equal sign.
Please don’t forget to do this.” Because I can’t afford skywriting, [ have to settle
for something more modest. | create a Remember icon.

Occasionally, I run across a technical tidbit. The tidbit may help you under-
stand what the people behind the scenes (the people who developed Java)
were thinking. You don’t have to read it, but you may find it useful. You may
also find the tidbit helpful if you plan to read other (more geeky) books
about Java.

This icon calls attention to useful material that you can find online. (You
don’t have to wait long to see one of these icons. I use one at the end of this
introduction!)

Beyond the Book

I've written a lot of extra content that you won'’t find in this book. Go online
to find the following:

+” Cheat Sheet: Check out www.dummies.com/cheatsheet/beginning
programmingwithjava.

+* Online Articles: On several of the pages that open each of this book’s
parts, you can find links to what the folks at For Dummies call Web
Extras, which expand on some concept I've discussed in that particular
section. You can find all such extras bundled together at www.dummies.
com/extras/beginningprogrammingwithjava.


http://www.dummies.com/cheatsheet/beginningprogrammingwithjava
http://www.dummies.com/cheatsheet/beginningprogrammingwithjava
http://www.dummies.com/extras/beginningprogrammingwithjava
http://www.dummies.com/extras/beginningprogrammingwithjava
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Where to Go from Here

If you've gotten this far, you're ready to start reading about computer pro-
gramming. Think of me (the author) as your guide, your host, your personal
assistant. [ do everything I can to keep things interesting and, most impor-
tantly, help you understand.

If you like what you read, send me an e-mail, post on my Facebook wall, or
tweet me a tweet. My e-mail address, which I created just for comments and
questions about this book, is BeginProg@allmycode.com. My Facebook
page is /allmycode, and my Twitter handle is @allmycode. And don’t forget —
to get the latest information, visit one of this book’s support websites. Mine is
at http://allmycode.com/BeginProg, or you can visit www.dummies.
com/go/beginningprogrammingwithjavafd

Occasionally, we have updates to our technology books. If this book does have
technical updates, they will be posted at www.dummies.com/go/beginning
programmingwithjavafdupdates and at http://allmycode.com/
BeginProg.


http://allmycode.com/beginprog
http://www.dummies.com/go/beginningprogrammingwithjavafd
http://www.dummies.com/go/beginningprogrammingwithjavafd
http://www.dummies.com/go/beginningprogrammingwithjavafdupdates
http://www.dummies.com/go/beginningprogrammingwithjavafdupdates
http://allmycode.com/beginprog
http://allmycode.com/beginprog
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In this part . . .

v Getting psyched up to be a Java developer
v Installing the software

v Running some sample programs




Chapter 1
Getting Started

In This Chapter
Realizing what computer programming is all about
Understanding the software that enables you to write programs

Revving up to use an integrated development environment

‘ omputer programming? What'’s that? Is it technical? Does it hurt? Is it
politically correct? Does Bill Gates control it? Why would anyone want
to do it? And what about me? Can I learn to do it?

What's It All About?

You’ve probably used a computer to do word processing. Type a letter, print
it, and then send the printout to someone you love. If you have easy access
to a computer, then you’ve probably surfed the web. Visit a page, click a link,
and see another page. It’s easy, right?

Well, it’s easy only because someone told the computer exactly what to do.

If you take a computer right from the factory and give no instructions to this
computer, the computer can’t do word processing, it can’t surf the web, and it
can’t do anything. All a computer can do is follow the instructions that people
give to it.

Now imagine that you're using Microsoft Word to write the great American
novel, and you come to the end of a line. (You're not at the end of a sentence;
just the end of a line.) As you type the next word, the computer’s cursor
jumps automatically to the next line of type. What’s going on here?

Well, someone wrote a computer program — a set of instructions telling the
computer what to do. Another name for a program (or part of a program) is
code. Listing 1-1 shows you what some of Microsoft Word’s code may look like.
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Listing 1-1: A Few Lines in a Computer Program

if (columnNumber > 60) {
wrapToNextLine () ;

} else {
continueSameLine () ;

}

If you translate Listing 1-1 into plain English, you get something like this:

If the column number is greater than 60,
then go to the next line.

Otherwise (if the column number isn't greater than 60),
then stay on the same line.

Somebody has to write code of the kind shown in Listing 1-1. This code, along
with millions of other lines of code, makes up the program called Microsoft
Word.

And what about web surfing? You click a link that’s supposed to take you
directly to Yahoo.com. Behind the scenes, someone has written code of the
following kind:

Go to <a href="http://www.yahoo.com">Yahoo</a>.

One way or another, someone has to write a program. That someone is called
a programmer.

Telling a computer what to do

Everything you do with a computer involves gobs and gobs of code. For exam-
ple, every computer game is really a big (make that “very big!”) bunch of com-
puter code. At some point, someone had to write the game program:

if (person.touches (goldenRing)) {
person.getPoints (10) ;

Without a doubt, the people who write programs have valuable skills. These
people have two important qualities:

v They know how to break big problems into smaller step-by-step
procedures.

v They can express these steps in a very precise language.
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A language for writing steps is called a programming language, and Java is just
one of several thousand useful programming languages. The stuff in Listing 1-1
is written in the Java programming language.

Pick your poison

This book isn’t about the differences among programming languages, but you
should see code in some other languages so you understand the bigger pic-
ture. For example, there’s another language, Visual Basic, whose code looks
a bit different from code written in Java. An excerpt from a Visual Basic pro-
gram may look like this:

If columnNumber > 60 Then
Call wrapToNextLine
Else
Call continueSameLine
End If

The Visual Basic code looks more like ordinary English than the Java code in
Listing 1-1. But, if you think that Visual Basic is like English, then just look at
some code written in COBOL:

IF COLUMN-NUMBER IS GREATER THAN 60 THEN
PERFORM WRAP-TO-NEXT-LINE

ELSE
PERFORM CONTINUE-SAME-LINE

END-IF.

At the other end of the spectrum, you find languages like Haskell. Here’s a
short Haskell program, along with the program’s input and output:

median alList =
[ x | x <- alist,
length([y | y <- alist, y < x]) ==
length([y | y <- alist, y > x])]
*Main> median [4,7,2,1,0,9,6]
[4]

Computer languages can be very different from one another, but in some ways,
they’re all the same. When you get used to writing IF COLUMN-NUMBER IS
GREATER THAN 60, you can also become comfortable writing if (column
Number > 60).It’s just a mental substitution of one set of symbols for another.
Eventually, writing things like if (columnNumber > 60) becomes second
nature.
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From Your Mind to the
Computer’s Processor

When you create a new computer program, you go through a multistep process.
The process involves three important tools:

v Compiler: A compiler translates your code into computer-friendly (human-
unfriendly) instructions.

v Virtual machine: A virtual machine steps through the computer-friendly
instructions.

v~ Application programming interface: An application programming inter-
face contains useful prewritten code.

The next three sections describe each of the three tools.

Translating your code

You may have heard that computers deal with zeros and ones. That’s cer-
tainly true, but what does it mean? Well, for starters, computer circuits don’t
deal directly with letters of the alphabet. When you see the word Start on
your computer screen, the computer stores the word internally as 01010011
01110100 01100001 01110010 01110100. That feeling you get of seeing
a friendly looking five-letter word is your interpretation of the computer
screen’s pixels, and nothing more. Computers break everything down into
very low-level, unfriendly sequences of zeros and ones and then put things
back together so that humans can deal with the results.

So what happens when you write a computer program? Well, the program has
to get translated into zeros and ones. The official name for the translation
process is compilation. Without compilation, the computer can’t run your
program.

[ compiled the code in Listing 1-1. Then I did some harmless hacking to
help me see the resulting zeros and ones. What [ saw was the mishmash in
Figure 1-1.

The compiled mumbo jumbo in Figure 1-1 goes by many different names:

1 Most Java programmers call it bytecode.

v~ 1 often call it a .class file. That’s because, in Java, the bytecode gets stored
in files named SomethingOrOther.class.

v To emphasize the difference, Java programmers call Listing 1-1 the source
code and refer to the zeros and ones in Figure 1-1 as object code.
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116001610 11111110 168111016 19111116 APBOOBO0 BOOPOBOR
0hBN0000 KP1P1110 BOOABOOD 0RP10101 APEON1610 POOBOBOR
AERR101 HPAREHAR BRP1PMA0A APPA1A16 APERAANR PBARO16H
AANRARPA HRA10HA1 BAAR1A1A ARARARAR AVHRA1VA PRAREBAA
AA1AA1A HAARA111 ARARAARR ARA1AA11 ABARA111 BARARABAA
000101600 HOOPOBO1 BOOPPBOOD DPPDO116 AP111100 01101661
91191110 01101601 6111601060 00111116 APBOOBH1 BOOBOBOR
0hER0011 PP1P16600 0161001 016101160 ABBOOGH1 BOABOBOR
ANRR100 P10AAAA11 A116A1111 A11680160 A1100101 BAARBBA1
AANRRRRA WERR1111 A10AA1108 A1101001 A11A1110 B1100181
910091110 611161601 61161101 011600016 A1100101 01116610
91010100 91100001 0110AA10 91101100 A110A1A1 AAAAAAA1
Figure 1-1: 0hBN00B0 POBR1611 61160100 011010601 A11160611 611166000

" ||91161100 91100001 01111001 01010111 A1161111 61116610

My || 91100100 PRARAGR1 PAARANAP PARRA1NP AA1010PA B1001061
computer || 88191801 A1A10110 PAAAAAA1L ARAPAARD ARPA1110 A1110111
understands || 91116616 81180061 61110600 A1016106 61161111 G1601110
91100161 611116600 6111601060 0100116060 A1101601 611011106

these zeros || @11@P101 PAPAPPPAL DPPPAVNAP APRP1APAD 0110PA11 @11@1111
and ones, || 81161110 01110160 011016601 01101110 01116161 01106161
but | don't A1910A11 P11A0BA1 H1101101 091100101 A16A1100 B1101001
1| 91191110 61160101 OPPOORG1 PPBOROOD PODP1010 B1A16611
e || 1161111 A111A161 A111AG10A A11AAA11 AI1AAI1A1 A1AAAI1A |

To visualize the relationship between source code and object code, see
Figure 1-2. You can write source code and then get the computer to create
object code from your source code. To create object code, the computer
uses a special software tool called a compiler.

Fig“'e;;]z if (columnNumber > 60)... | Javasourcefile(a .java file)
e

computer )
compiles Compiler
source code

[tocreate 11001010 11111110 Objectfile (a . c1ass file) also known as bytecode
object code.

Your computer’s hard drive may have a file named javac or javac.exe. This
file contains that special software tool — the compiler. (Hey, how about that?
The word javac stands for “Java compiler!”) As a Java programmer, you often
tell your computer to build some new object code. Your computer fulfills this
wish by going behind the scenes and running the instructions in the javac file.

Running code

Several years ago, I spent a week in Copenhagen. I hung out with a friend who
spoke both Danish and English fluently. As we chatted in the public park, I
vaguely noticed some kids orbiting around us. [ don’t speak a word of Danish,
so [ assumed that the kids were talking about ordinary kid stuff.
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What is bytecode, anyway?

Look at Listing 1-1 and at the listing's transla-
tion into bytecode in Figure 1-1. You may be
tempted to think that a bytecode file is just a
cryptogram — substituting zeros and ones for
the letters in words like 1 £ and else. But it
doesn't work that way at all. In fact, the most
important part of a bytecode file is the encoding
of a program'’s logic.

The zeros and ones in Figure 1-1 describe the
flow of data from one part of your computer to
another. | illustrate this flow in the following
figure. But remember, this figure is just an illus-
tration. Your computer doesn’t look at this par-
ticular figure, or at anything like it. Instead, your
computer reads a bunch of zeros and ones to
decide what to do next.

columnNumber

60

N

Subtract 60 from columnNumber.
Store the following info:
Is the result negative?
Is the result zero?

result not
negative

result
not zero

wrap

result is
negative

result

~

is zero

\

continue

Don't bother to absorb the details in my attempt
at graphical representation in the figure. It's not
worth your time. The thing you should glean
from my mix of text, boxes, and arrows is that
bytecode (the stuffin a . class file) contains
a complete description of the operations that
the computer is to perform. When you write a

computer program, your source code describes
an overall strategy — a big picture. The com-
piled bytecode turns the overall strategy into
hundreds of tiny, step-by-step details. When the
computer “runs your program,” the computer
examines this bytecode and carries out each of
the little step-by-step details.
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|
Figure 1-3:
What the
computer
gleans from
a bytecode
file.
|

Then my friend told me that the kids weren’t speaking Danish. “What language
are they speaking?” I asked.

“They’re talking gibberish,” she said. “It’s just nonsense syllables. They don’t
understand English, so they’re imitating you.”

Now to return to present-day matters. I look at the stuff in Figure 1-1, and I'm
tempted to make fun of the way my computer talks. But then I'd be just like
the kids in Copenhagen. What’s meaningless to me can make perfect sense to
my computer. When the zeros and ones in Figure 1-1 percolate through my
computer’s circuits, the computer “thinks” the thoughts shown in Figure 1-3.

Get columnNumber from memory.
Get 60 from memory.
Subtract 60 from columnNumber.
Store the following info:
Is the result negative?
Is the result zero?
If the result is negative, then continue.
If the result is not negative, then
check to see if the result is zero.
If the result is zero, then continue.
If the result is not zero, then wrap.

01001110 01110101 01101101 01100010 01100101 01110010
01010100 01100001 01100010 01101100 01100101 00000001
00000000 00001011 01100100 01101001 01110011 01110000
01101100 01100001 01111001 01010111 01101111 01110010

Everyone knows that computers don’t think, but a computer can carry out
the instructions depicted in Figure 1-3. With many programming languages
(languages like C++ and COBOL, for example), a computer does exactly what
I’'m describing. A computer gobbles up some object code and does whatever
the object code says to do.



18

Part |: Getting Started with Java Programming

Figure 1-4:
How a
computer
runs a Java
program.
|

That’s how it works in many programming languages, but that’s not how it
works in Java. With Java, the computer executes a different set of instructions.
The computer executes instructions like the ones in Figure 1-4.

Carry out the first instruction in Figure 1-3.
Carry out the second instruction in Figure 1-3.
Carry out the third instruction in Figure 1-3.
Keep going until you encounter an "If."
When you encounter an "If," then decide which of
the two alternative paths you should follow.
Carry out the instructions in the path that you choose.

The instructions in Figure 1-4 tell the computer how to follow other instruc-
tions. Instead of starting with Get columnNumber from memory, the comput-
er’s first instruction is, “Do what it says to do in the bytecode file.” (Of course,
in the bytecode file, the first instruction happens to be Get columnNumber
from memory.)

There’s a special piece of software that carries out the instructions in Figure 1-4.
That special piece of software is called the Java Virtual Machine (JVM). The JVM
walks your computer through the execution of some bytecode instructions.
When you run a Java program, your computer is really running the JVM. That
JVM examines your bytecode, zero by zero, one by one, and carries out the
instructions described in the bytecode.

Many good metaphors can describe the JVM. Think of the JVM as a proxy, an
errand boy, a go-between. One way or another, you have the situation shown
in Figure 1-5. On the (a) side is the story you get with most programming
languages — the computer runs some object code. On the (b) side is the story
with Java — the computer runs the JVM, and the JVM follows the bytecode’s
instructions.



Figure 1-5:
Two ways
toruna
computer
program.

instructions in the java file.

Your computer’s hard drive may have files named javac and java (or
javac.exe and java.exe). A java (or java.exe) file contains the instruc-
tions illustrated previously in Figure 1-4 — the instructions in the JVM. As
a Java programmer, you often tell your computer to run a Java program.
Your computer fulfills this wish by going behind the scenes and running the

Chapter 1: Getting Started

Write once, run anywhere

When Java first hit the tech scene in 1995, the
language became popular almost immediately.
This happened in part because of the JVM.
The JVM is like a foreign language interpreter,
turning Java bytecode into whatever native lan-
guage a particular computer understands. So if
you hand my Windows computer a Java byte-
code file, then the computer's JVM interprets the
file for the Windows environment. If you hand
the same Java bytecode file to my colleague’s
Macintosh, then the Macintosh JVM interprets
that same bytecode for the Mac environment.

Look again at Figure 1-5. Without a virtual
machine, you need a different kind of object

code for each operating system. But with the
JVM, just one piece of bytecode works on
Windows machines, Unix boxes, Macs, or
whatever. This is called portability, and in the
computer-programming world, portability is a
very precious commodity. Think about all the
people using computers to browse the Internet.
These people don't all run Microsoft Windows,
but each person’s computer can have its own
bytecode interpreter — its own JVM.

The marketing folks at Oracle call it the Write
Once, Run Anywhere model of computing. | call
it a great way to create software.
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Code you can use

During the early 1980s, my cousin-in-law Chris worked for a computer soft-
ware firm. The firm wrote code for word-processing machines. (At the time,
if you wanted to compose documents without a typewriter, you bought a
“computer” that did nothing but word processing.) Chris complained about
being asked to write the same old code over and over again. “First, | write

a search-and-replace program. Then [ write a spell checker. Then I write
another search-and-replace program. Then, a different kind of spell checker.
And then, a better search-and-replace.”

How did Chris manage to stay interested in his work? And how did Chris’s
employer manage to stay in business? Every few months, Chris had to rein-
vent the wheel. Toss out the old search-and-replace program and write a new
program from scratch. That’s inefficient. What’s worse, it’s boring.

For years, computer professionals were seeking the Holy Grail — a way to
write software so that it’s easy to reuse. Don’t write and rewrite your search-
and-replace code. Just break the task into tiny pieces. One piece searches

for a single character, another piece looks for blank spaces, and a third piece
substitutes one letter for another. When you have all the pieces, just assem-
ble these pieces to form a search-and-replace program. Later on, when you
think of a new feature for your word-processing software, you reassemble the
pieces in a slightly different way. It’s sensible, it’s cost efficient, and it’s much
more fun.

The late 1980s saw several advances in software development, and by the
early 1990s, many large programming projects were being written from prefab
components. Java came along in 1995, so it was natural for the language’s
founders to create a library of reusable code. The library included about

250 programs, including code for dealing with disk files, code for creating
windows, and code for passing information over the Internet. Since 1995, this
library has grown to include more than 4,000 programs. This library is called
the Application Programming Interface (API).

Every Java program, even the simplest one, calls on code in the Java APIL.
This Java API is both useful and formidable. It’s useful because of all the
things you can do with the API's programs. It’s formidable because the API is
so extensive. No one memorizes all the features made available by the Java
API. Programmers remember the features that they use often and look up the
features that they need in a pinch. They look up these features in an online
document called the API Specification (known affectionately to most Java pro-
grammers as the APl documentation, or the Javadocs).
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The API documentation (see http://docs.oracle.com/javase/8/
docs/api/) describes the thousands of features in the Java API. As a Java
programmer, you consult this APl documentation on a daily basis. You can
bookmark the documentation at the Oracle website and revisit the site when-
ever you need to look up something, or you can save time by downloading
your own copy of the API docs using the links found at www.oracle.com/
technetwork/java/javase/downloads/index.html.

Vour Java Programming Toolset
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To write Java programs, you need the tools described previously in this
chapter:

+” You need a Java compiler. (Refer to the section “Translating your code.”)
+* You need a JVM. (Refer to the section “Running code.”)
+* You need the Java API. (Refer to the section “Code you can use.”)

+* You need access to the Java API documentation. (Again, refer to the
“Code you can use” section.)

You also need some less exotic tools:

+* You need an editor to compose your Java programs. Listing 1-1 contains
part of a computer program. When you come right down to it, a computer
program is a big bunch of text. So to write a computer program, you need
an editor — a tool for creating text documents.

An editor is a lot like Microsoft Word, or like any other word-processing
program. The big difference is that an editor adds no formatting to your
text — no bold, italic, or distinctions among fonts. Computer programs
have no formatting whatsoever. They have nothing except plain old letters,
numbers, and other familiar keyboard characters.

When you edit a program, you may see bold text, italic text, and text in
several colors. But your program contains none of this formatting. If you
see stuff that looks like formatting, it’s because the editor that you're using
does syntax highlighting. With syntax highlighting, an editor makes the text
appear to be formatted in order to help you understand the structure of
your program. Believe me, syntax highlighting is very helpful.

+ You need a way to issue commands. You need a way to say things like
“compile this program” and “run the JVM.” Every computer provides
ways of issuing commands. (You can double-click icons or type verbose
commands in a Run dialog box.) But when you use your computer’s facili-
ties, you jump from one window to another. You open one window to read
Java documentation, another window to edit a Java program, and a third
window to start up the Java compiler. The process can be very tedious.
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In the best of all possible worlds, you do all your program editing, documen-
tation reading, and command issuing through one nice interface. This inter-
face is called an integrated development environment (IDE).

A typical IDE divides your screen’s work area into several panes — one pane
for editing programs, another pane for listing the names of programs, a third
pane for issuing commands, and other panes to help you compose and test
programs. You can arrange the panes for quick access. Better yet, if you change
the information in one pane, the IDE automatically updates the information in
all the other panes.

An IDE helps you move seamlessly from one part of the programming endeavor
to another. With an IDE, you don’t have to worry about the mechanics of edit-
ing, compiling, and running a JVM. Instead, you can worry about the logic of
writing programs. (Wouldn’t you know it? One way or another, you always have
something to worry about!)

What's already on your hard drive?

You may already have some of the tools you need for creating Java programs.
But, on an older computer, your tools may be obsolete. Most of this book’s
examples run on all versions of Java. But some examples don’t run on versions
earlier than Java 5.0. Other examples run only on Java 6, Java 7, Java 8, or later.

The safest bet is to download tools afresh from java.com or from the Oracle
website. To get detailed instructions on doing the download, see Chapter 2.

Eclipse

The programs in this book work with any IDE that can run Java. This includes
IDEs such as NetBeans, IntelliJ IDEA, JDeveloper, JCreator, and others. You
can even run the programs without an IDE. But to illustrate the examples in
this book, I use the Eclipse IDE. I chose Eclipse over other IDEs for several
reasons:

v Eclipse is free.

v Among all the Java IDEs, Eclipse is the one most commonly used by pro-
fessional programmers.

v Eclipse has many bells and whistles, but you can ignore most of them
and learn to repeat a few routine sequences of steps. After using Eclipse
a few times, your brain automatically performs the routine steps. From
then on, you can stop worrying about Eclipse and concentrate on Java
programming.

v Eclipse is free. (It’s worth mentioning twice.)
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In This Chapter

Installing Java

Downloading and installing the Eclipse integrated development environment

Checking your Eclipse configuration

Getting the code in this book’s examples
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Fis book tells you how to write Java programs, and before you can write
Java programs, you need some software. At the very least, you need the
software that I describe in Chapter 1 — a Java compiler and a Java Virtual
Machine (JVM, for short). You can also use a good integrated development
environment (IDE) and some sample code to get you started.

All the software you need for writing Java programs is free. The software comes
as three downloads — one from this book’s website, another from Oracle, and
a third from eclipse.org.

The Oracle and Eclipse websites that I describe in this chapter are always
changing. The software that you download from these sites changes, too. A spe-
cific instruction such as “click the button in the upper-right corner” becomes
obsolete (and even misleading) in no time at all. So in this chapter, [ provide
long lists of steps, but I also describe the ideas behind the steps. Browse each
of the suggested sites and look for ways to get the software that I describe.
When a website offers you several options, check the instructions in this chap-
ter for hints on choosing the best option. If your computer’s Eclipse window
doesn’t look quite like the window in this chapter’s figures, scan your com-
puter’s window for whatever options I describe. If, after all that, you can’t find
what you’re looking for, check this book’s website (http://allmycode.com/
BeginProg) or send an e-mail to me at BeginProg@allmycode . com. You
can also find me on Facebook at /allmycode or on Twitter at @allmycode.


http://allmycode.com/beginprog
http://allmycode.com/beginprog
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If You Don’t Like Reading
Instructions . . .

\\J

[ start this chapter with a very brief (but useful) overview of the steps required
to get the software you need. If you're an old hand at installing software, and if
your computer isn’t quirky, these steps will probably serve you well. If not, you
can read the more detailed instructions in the next several sections.

Here’s how you get the software for creating Java programs:

1. Visit http://allmycode.com/BeginProg and download a file con-

taining all the program examples in this book.

. Visit www.oracle.com/technetwork/java/javase/downloads

and get the latest available version of the JDK.

Choose a version of the software that matches your operating system
(Windows, Macintosh, or whatever). If you have trouble choosing between
32-bit software and 64-bit software, the 32-bit versions are safer choices. If
you have trouble choosing between the JRE and the JDK, pick the JDK.

If you're in a hurry (and who isn’t?), you may benefit from a quick visit to
http://java.com The http://java.com website offers a hassle-free,
one-click Java installer. (Simply click a big Java Download button. You can’t
miss it.) The Java Download button doesn’t work on all computers. But if
it works for you, with a wave of a virtual magic wand, you're finished with
this step. You can bypass the complexities of the oracle . com website
and move immediately to Step 3.

. Visit http://eclipse.org/downloads and get the Eclipse IDE.

Select the Eclipse IDE For Java Developers. The resulting download is a
compressed archive file (for Windows, a . zip file; for other operating
systems, including Macintosh OS X, a . tar.gz file).

. Extract the contents of the downloaded Eclipse archive.

The archive contains a folder named eclipse. Extract this eclipse
folder to a handy place in your computer’s hard drive. For example, on
my Windows computer, [ have a C: \eclipse folder. On my Mac, [ have
an eclipse folder inside my 2pplications folder.

In Windows, the blank space in the name Program Files confuses some
Java software. I don’t think any of this book’s software presents such a
problem, but I can’t guarantee it. So if you want, extract Eclipse to your
C:\Program Filesor C:\Program Files (x86) folder. But make a
mental note about your choice (in case you run into any trouble later).


http://allmycode.com/beginprog
http://www.oracle.com/technetwork/java/javase/downloads
http://java.com
http://java.com
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http://eclipse.org/downloads
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5. Launch Eclipse and click the Welcome screen’s Workbench icon.

Initially, the Welcome screen’s icons have no text labels. But when you
hover over an icon, a tooltip appears. Select the icon whose tooltip has

the title Workbench.

6. In Eclipse, import the code that you downloaded in Step 1.

For details about any of this stuff, see the next several sections.

Those pesky filename extensions

The filenames displayed in Windows File
Explorer or in a Finder window can be mislead-
ing. You may browse one of your directories and
see the name Mortgage. The file's real name
might be Mortgage.java, Mortgage.
class, Mortgage. somethingElse, or
plain old Mortgage. Filename endings like
.zip, .java, and .class are called file-
name extensions.

The ugly truth is that, by default, Windows and
Macs hide many filename extensions. This
awful feature tends to confuse programmers.
So, if you don’t want to be confused, change
your computer’s system-wide settings. Here's
how you do it:

v In Windows XP: Choose Start=>Control
Panel=>Appearance and Themes=>Folder
Options. Then follow the instructions in the
In All Versions of Windows bullet.

+ In Windows 7: Choose Start=>Control
Panel=>Appearance and Personalization=>
Folder Options. Then follow the instruc-
tions in the In All Versions of Windows
bullet.

+* In Windows 8: In the Start screen, hold
down the Windows key while pressing Q.

In the resulting search box, type Folder
Options and then press Enter. Then follow
the instructions in the In All Versions of
Windows bullet.

In all versions of Windows (XP and newer):
Follow the instructions in one of the pre-
ceding bullets. Then, in the Folder Options
dialog box, click the View tab. Look for the
Hide File Extensions for Known File Types
option. Make sure that this check box is not
selected.

In Mac 0S X: In the Finder application’s
menu, select Preferences. In the resulting
dialog box, select the Advanced tab and
look for the Show All File Extensions option.
Make sure that this check box /s selected.

In Linux: Linux distributions tend not to
hide filename extensions. So, if you use
Linux, you probably don’t have to worry
about this. But | haven't checked all Linux
distributions. So, if your files are named
Mortgage instead of Mortgage.
java or Mortgage.class, check
the documentation specific to your Linux
distribution.
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Getting This Book’s Sample Programs

To get copies of this book’s sample programs, visit http://allmycode.
com/BeginProg and click the link to download the programs in this book.

Save the download file (BeginProgJavaDummies4 . zip) to your computer’s

hard drive.

In some cases, you click a download link, but your web browser doesn’t offer

you the option to save a file. If this happens to you, right-click the link (or
control-click on a Mac). In the resulting context menu, select Save Target As,
Save Link As, Download Linked File As, or a similarly labeled menu item.

Most web browsers save files to a Downloads directory on your com-
puter’s hard drive. But your browser may be configured a bit differently.
One way or another, make note of the folder containing the downloaded
BeginProgJdavaDummies4 . zip file.

Compressed archive files

When you visithttp: //allmycode.com/
BeginProg and you download this book's
Java examples, you download a file named
BeginProgJavaDummies4 .zip. A
. zipfile is a single file that encodes a bunch
of smaller files and folders. So, for example,
my BeginProgJavaDummies4.zip
file encodes folders named 06-01, 06-02,
and so on. The 06-02 folder contains some
subfolders, which in turn contain files. (The
folder named 06-02 contains the code in
Listing 6-2 — the second listing in Chapter 6.)

A .zip file is an example of a compressed
archive file. Some other examples of com-
pressed archives include .tar.gz files,
.rar files, and . cab files. Uncompressing
a file means extracting the original files
stored inside the big archive file. (Fora . zip
file, another word for “uncompressing” is
“unzipping.”) Uncompressing normally re-
creates the folder structure encoded in the
archive file. So, after uncompressing my

BeginProgJdavaDummies4 . zip file, your
hard drive has folders named 06-01, 06-02,
with subfolders named src and bin, which in
turn contain files named SnitSoft.java,
SnitSoft.class, and soon.

When you download BeginProgJdava
Dummies4 .zip, your web browser may
uncompress the file automatically for you. If not,
you can see the . zipfile's contents by double-
clicking the file’s icon. (In fact, you can copy
the file's contents and perform some other file
operations after double-clicking the file's icon.)
One way or another, don’t worry about uncom-
pressing my BeginProgJavaDummies4 .
zip file. When you follow this chapter’s
instructions, you import the contents of my
BeginProgJavaDummies4 .zip file
into the Eclipse IDE. And behind the scenes,
Eclipse’s import process uncompresses the
. zipfile.



http://allmycode.com/beginprog
http://allmycode.com/beginprog
http://allmycode.com/beginprog
http://allmycode.com/beginprog

Chapter 2: Setting Up Your Computer 2 7

Setting Up Java

You can get the latest, greatest versions of Java by visiting www.oracle.com/
technetwork/java/javase/downloads. Look for the newest available
version of the JDK. Select a version that runs on your computer’s operating
system. Figure 2-1 shows me clicking a Download JDK button (circa March
2014) at the Oracle website.

Oyerview Downloads Documentation Community Technologies Training

Java SE Downloads

—

DOWNLOAD *

Jawva Platform (JDK) 8

Javar 2 NetBeans

DOWNLOAD #

JDK 8 & NetBeans 8.0

| Java Platform, Standard Edition

Java SE8

This new major release contains several new features and enhancements that increase the
performance of existing applications, make it easier to develop applications for modem
platforms, and increase maintainability of code.

Learn more #

= Installation Instructions
= Release Motes

= Oracle License

Java SE Products

Third Party Licenses

Cerified System Configurations

JDK 8
DOWNLOAD #

1

Server JRE
8

|
) * Readme Files
Figure 2-1: - JDKReadMe JRE 8
1 DOWNLOAD #
Getting the « JRE ReadMe
Java JDK.
|

If you can’t identify the most appropriate Java version or if you want to know
what the acronyms JRE and JDK stand for, see the sidebar entitled “Eenie,
meenie, miney mo.”


http://www.oracle.com/technetwork/java/javase/downloads
http://www.oracle.com/technetwork/java/javase/downloads
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After you accept a license agreement and click a link to a Java installation file,
your computer does one of two things:

v Downloads and installs Java on your system.

v Downloads the Java installation file and saves the file on your computer’s
hard drive.

If the installation begins on its own, follow the instructions, answer “Yes” to

any prompts, and (unless you have good reason to do otherwise) accept the
defaults. If the installation doesn’t begin on its own, start the installation by

double-clicking the downloaded installation file.

Eenie, meenie, miney mo

The Java Standard Edition download page
(www.oracle.com/technetwork/
java/javase/downloads) has many
options. If you're not familiar with these options,
the page can be intimidating. Here are some of
the choices on the page:

v+ Word length: 32-hit or 64-bit

You may have to choose between links
labeled for 32-bit systems and links labeled
for 64-bit systems. If you don't know which
to choose, start by trying the 32-bit version.
(For more information about 32-bit systems
and 64-bit systems, see the “How many bits
does your computer have?” sidebar.)

v~ Java version number

The Java download page may have older
and newer Java versions for you to choose
from. You may see links to Java SE 7,
Java SE 8, Java SE 8u4, and many others.
(Numbering such as 8u4 stands for the
fourth update to Java 8.) If you're not sure
which version number you want, choosing
the highest version number is probably safe.
Most of this book’s examples run on a com-
puter with Java 5 installed. A few examples
run only on Java 7, Java 8, or higher.

The numbering of Java’s versions is really
confusing. First comes Java 1.0, then Java
1.1, and then Java 2 Standard Edition 1.2

(J2SE 1.2). Yes, the “Java 2" numbering
overlaps partially with the “1.x" numbering.
Next come versions 1.3 and 1.4. After ver-
sion 1.4.1 comes version 1.4.2 (with interme-
diate stops at versions like 1.4.1_02). After
1.4.2_06, the next version is version 1.5,
which is also known as version 5.0. (That's
no misprint. Version 5.0 comes immediately
after the 1.4 versions.)

The formal name for version 1.5 is “Java
2 Platform, Standard Edition 5.0.” And to
make matters even worse, the next big
release is “Java Platform, Standard Edition
6" with the “2” removed from “Java 2" and
the “.0" missing from “6.0.” That's what
happens when a company lets marketing
people call the shots.

Mercifully, from Java 6 onward, the ver-
sion numbers settle into a predictable pat-
tern. After Java 6 comes “Java Platform,
Standard Edition 7" and “Java Platform,
Standard Edition 8" with updates such as
“8u02” (meaning “Java 8, update 2”).

JDK versus JRE

The download page offers you a choice
between the JDK (Java Development Kit)
and the JRE (Java Runtime Environment).
The JDK download contains more stuff
than the JRE download. The JRE includes
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a Java Virtual Machine and the Application
Programming Interface (refer to Chapter 1).
The JDK includes everything in the JRE,
and in addition, the JDK includes a Java
compiler (again, refer to Chapter 1).

The Eclipse IDE contains its own Java
compiler. So, you can survive by download-
ing the smaller JRE (avoiding the big JDK
download). But | recommend downloading
the entire JDK. Why? Because you never
know when another compiler (separate
from Eclipse) will come in handy. Besides,
the installation and configuration of Eclipse
on a Mac is convoluted if you haven't
installed the full JDK. So, if you want to
have a smooth ride, download the JDK
instead of the JRE.

By the way, another name for the JDK
is the Java SDK — the Java Software
Development Kit. Some people still use
the SDK acronym, even though the folks
at Oracle don't use it anymore. (Actually,
the original name was the JDK. Later, Sun
Microsystems changed it to the SDK. A
few years after that, the captains of Java
changed back to the name JDK. This con-
stant naming and renaming drives me crazy
as an author.)

Java SE versus Java EE versus Java ME

While you wander around, you may notice
links labeled Java EE or Java ME. If you
know what these are, and you know you
need them, by all means, download these
goodies. But if you're not sure, bypass both
the Java EE and the Java ME links. Instead,
follow links to the Java SE (Java Standard
Edition).

The abbreviation Java EE stands for Java
Enterprise Edition and Java ME stands for
Java Micro Edition. The Enterprise Edition
has software for large businesses, and the
Micro Edition has software for handheld
devices. (Google’s Android software bears
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a passing resemblance to Java's Micro
Edition, but in many ways, Android and
Java ME are very different animals.)

You don't need the Java EE or the Java ME
to run any of the examples in this book.

Additional Java-related software

You can download Java alone, or you can
download Java with Oracle’s NetBeans
IDE. You can download a collection of
demos and samples. You can probably even
download Java with fries and a soft drink.
You can download plenty of extra stuff, but
in truth, all you need is the Java JDK.

Installation type

You may be prompted to choose between
online installation and offline installation.

With the offline installation, you begin by
downloading a large setup file. The file
takes up lots of space on your hard drive
(between 30MB and 150MB, depending on
what you choose to download). If you ever
need to install the JDK again, you have the
file on your own computer. Until you want a
newer version of the JDK, you don't need to
download the JDK again.

Why would anyone want to install the same
version of the JDK a second time? Typically,
| have two reasons. Either | want to install
the software on a second computer, or |
mess something up and have to uninstall
(and then reinstall) the software.

With the online installation, you don’t down-
load a big setup file. Instead, you download
a teeny little setup file. Then you download
(and discard) pieces of the big 30MB to
150MB file as you need them. Using online
installation saves you many megabytes of
hard drive space. But, if you want to install
the same version of the JDK a second
time, you have to redo the whole surf/click/
download process.
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If your computer runs Linux, the downloaded file might be a . tar.gz file. A
.tar.gz file is a compressed archive. Extract the archive’s contents to a folder of
your choice and follow the installation instructions posted on the Oracle website.

For more information about filenames, file types, and archives, see the sidebars
entitled “Those pesky filename extensions” and “Compressed archive files” in
this chapter.

While you're visiting www.oracle.com/technetwork/java/javase/
downloads, you can also download a copy of the Java APl documentation. Look
for a download labeled Java SE Development Kit Documentation (or something
like that). Accept the license agreement, click the download link, and watch the
file flow downward onto your computer’s hard drive. The downloaded file is a
compressed . zip archive, so you can uncompress it the way you uncompress
all other such archives. (The uncompressed folder is a bunch of web pages. To
start reading the Java APl documentation, look in that folder for an index file or
an index.html file. Double-click the file, and you're on your way.)

For an introduction to the Java API documentation, refer to Chapter 1.

Most people have no difficulties visiting the Oracle website http://oracle.
com/ and installing Java using the website’s menus. But if your situation is more
“interesting” than most, you may have to make some decisions and perform some
extra steps. The next few sections describe some of these “interesting” scenarios.

How many bits does your computer have?

As you follow this chapter's instructions, you
may be prompted to choose between two
versions of a piece of software — the 32-bit
version and the 64-bit version. What's the dif-
ference, and why should you care?

A bit is the smallest piece of information that
you can store on a computer. Most people think
of a bit as either a zero or a one, and that depic-
tion of “bit” is quite useful. To represent almost
any number, you pile several bits next to one
another and do some fancy things with powers
of two. The numbering system’s details aren't
show stoppers. The important thing to remem-
ber is that each piece of circuitry inside your
computer stores the same number of bits. (Well,
some circuits inside your computer are outliers
with their own particular numbers of bits, but
that’s not a big deal.)

In an older computer, each piece of circuitry
stores 32 bits. In a newer computer, each piece
of circuitry stores 64 bits. This number of bits
(either 32 or 64) is the computer's word length.
In a newer computer, a word is 64 bits long.

“Great!” you say. “l bought my computer last
week. It must be a 64-bit computer.” Well, the
story may not be that simple. In addition to your
computer’s circuitry having a word length, the
operating system on your computer also has a
word length. An operating system’s instructions
work with a particular number of bits. An oper-
ating system with 32-bit instructions can run on
either a 32-bit computer or a 64-bit computer,
but an operating system with 64-bit instruc-
tions can run only on a 64-bit computer. And
to make things even more complicated, each
program that you run (a web browser, a word
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processor, or one of your own Java programs)
is either a 32-bit program or a 64-bit program.
You may run a 32-bit web browser on a 64-bit
operating system running on a 64-bit computer.
Alternatively, you may run a 32-hit browser on
a 32-bit operating system on a 64-hit computer.
(See the figure that accompanies this sidebar.)

v If you run a 32-bit operating system, you run
only 32-bit software.

v If you run a 64-bit operating system, you
probably run some 32-bit software and
some 64-bit software. Most 32-bit software
runs fine on a 64-bit operating system.

— 32-bit computer

— 32-bit operating system

r 32-bit software —I

— 64-bit computer

— 32-bit operating system

r 32-bit software —I

— 64-bit computer

— 64-bit operating system

[ 32-bit software —| [ 64-bit software —|

When a website makes you choose between
32-bit and 64-bit software versions, the main
consideration is the word length of your oper-
ating system, not the word length of your com-
puter's circuitry. You can run a 32-bit word
processor on a 64-bit operating system, but you
can't run a 64-bit word processor on a 32-bit
operating system (no matter what word length
your computer’s circuitry has). Choosing 64-bit
software has one big advantage — namely, that
64-bit software can access more than three
gigabytes of a computer’s fast random access
memory. And in my experience, more memory
means faster processing.

How does all this stuff about word lengths
affectyour Java and Eclipse downloads? Here's
the story:

v On a 64-bit operating system, you might
have two versions of the same program. For
example, on my Windows computer, | have
two versions of Internet Explorer — a 32-bit
version and a 64-bit version.

Normally, Windows puts 32-bit programs in
its Program Files (x86) directory
and puts 64-bit programs in its Program
Files directory.

v A chain of word lengths is as strong as
its weakest link. For example, when | visit
http://java.com and click the site's
Do | Have Java? link, the answer | get
depends on the match between my comput-
er's Java version and the web browser that
I'm running. With only 64-bit Java installed

(continued)
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(continued)

on my computer, the Do | Have Java? link
in my 32-bit Firefox browser answers No
working Java was detected
on your system. Butthe same linkin
my 64-bit Internet Explorer answers You
have the recommended Java
installed.

On a Mac, Safari and Firefox are 64-bit
browsers, but Chrome is a 32-bit browser.
So on a Mac, you're likely to see slightly dif-
ferent behavior when using Firefox versus
Chrome.

Here's the most important thing to remem-
ber about word lengths: When you follow
this chapter’s instructions, you get Java
software and Eclipse software on your
computer. Your Java software’s word length

must match your Eclipse software’s word
length. In other words, 32-bit Eclipse runs
with 32-bit Java, and 64-bit Eclipse runs
with 64-bit Java. | haven't tried all possible
combinations, but when | try to run 32-bit
Eclipse with 64-bit Java, | see a misleading
No Java virtual machine was
found error message.

Finally, some websites use unintuitive
names for their software downloads. If
you see 365 or 1586 in the name of a down-
load, that usually means 32-bit. If you see
x86 without the number 64 anywhere in a
download’s name, that also means 32-bits.
If you see 64 in the name (with or without
the x86 designation), that indicates a 64-bit
program.

Finding Java on your computer

Chapter 1 describes the Java ecosystem with its compiler, its virtual machine,
and its other parts. Your computer may already have some of these Java
gizmos. If so, you can either live with what you already have or add the newest
version of Java to whatever is already on your system.

Java’s versions aren’t like indoor cats. They can coexist on the same computer
without fighting or hissing at one another. If you have more than one version of
Java on your computer, you're okay. You can even mix 32-bit versions and 64-bit
versions on the same computer (as long as you have at least one Java version
whose word length matches your Eclipse version). I have three versions of Java
on my Windows 8 computer, and I never run into trouble. (Occasionally, I cause
my own trouble by confusing one version of Java for another. But this chapter’s
“Configuring Java in Eclipse” section helps me sort things out. What would I do
without this book by my side?)

To find out what you already have and possibly avoid reinstalling Java, keep
reading.

On Windows 8

In the Start screen, hold down the Windows key while pressing Q. In the result-
ing search box, type Programs and Features and then press Enter. Then pro-
ceed to the In All Versions of Windows (XP and Newer) paragraphs.
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|
Figure 2-2:
The
Programs
and
Features
dialog

box on
Windows 8.
|
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On Windows 7

Select Start=>Control Panel=>Programs=>Programs and Features. Then follow
the instructions in the In All Versions of Windows (XP and Newer) paragraphs.

On Windows XP

Select Start=>Control Panel=>Add or Remove Programs. Then follow the instruc-
tions in the In All Versions of Windows (XP and Newer) paragraphs.

In all versions of Windows (XP and newer)

Look for Java in the list of installed programs (see Figure 2-2). If you see Java 8
or higher, you're okay. If the only Java version numbers that you see are lower
than 8 (such as 1.4.2, 5.0, or 6), your computer can run some (but not all) of
the programs in this book.

By aBackn

| £ Java T Update 51
| £ Java B (B4-hit)

[GljaRrasp

| £:|Java SE Dewveloprment Kit 7 Update 25

| £:|Jawva SE Developrment Kit 8 {64-bit)

|| Java(Th) 6 Update 32 (63-bit)

| £ Java(Th) SE Development Kit 6 Update 32 (64-bit)
JawaFX Scene Builder 1.1
JawaFx Scene Builder 2.0

Hitek Software
Oracle

Oracle Corporation
Oracle

Oracle Corporation
Oracle

Oracle

Oracle

Oracle

107972013
6/24/2013
3/20/2014
9/6/2013

3/20/2014
171872013
171872013
171972014
3/2/2014

1/3/2014

95.0MB
129 MB
129 MEB
134 Mg
248 B
92.0MB
128 MB
128 MEB
143 Mg

9.00.0000
7.0510
800
1.7.0.250
8.00
6.0.320
1.6.0320
11

.0
2.0.0.07

If the version number is 5.0 or higher, you can run many (but not all) of the
programs in this book.

On a Mac

A Macintosh computer can support two different flavors of Java — a flavor
developed in-house at Apple, Inc., and another flavor developed under Oracle’s
auspices. Certain commands and procedures apply to one flavor of Java but
not to the other. For example, to find Apple’s version of Java, you look in the
/System/Library/Java/Java Virtual Machines directory. But to find
Oracle’s Java, you look in the /Library/Java/JavaVirtualMachines
directory. (One path starts with /System/Library; the other path starts with
/Library.) You might also find Oracle’s Java in the /Library/Internet
Plug-Ins/JavalAppletPlugin.plugin/Contents/Home directory.

Tiger, Leopard, and Snow Leopard (OS X 10.4, OS X 10.5, and OS X 10.6) have
Java preinstalled. Java isn’t preinstalled on Lion, Mountain Lion, or Mavericks
(05§ X 10.7,0S X 10.8, or OS X 10.9). On Lion, Mountain Lion, or Mavericks,
the system prompts you to install either Apple’s Java or Oracle’s Java the
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first time you launch an application that requires Java. (For example, later in
this chapter, you install Eclipse. When you first try to launch Eclipse, if you
haven’t already installed Java, your computer advises you to do so.)

Table 2-1 describes the correlations between Mac OS and Java versions.

Table 2-1 Mac 0S X Versions and Java Versions

If You Have This Mac Then You Have This And You Can Install This

0S X Version . .. Version of Java . .. Java Version

0S X 10.4.11 (Tiger) Apple’s Java 5.0 Apple’s Java 5.0

0S X 10.5.8 (Leopard) Apple’s Java 5.0 Apple's Java 5.0

PowerPC and/or 32-bit

0S X 10.5.8 (Leopard) Apple's Java 6 Apple's Java 6

Intel-based and 64-bit

0S X 10.6.8 (Snow Apple’s Java 6 Apple’s Java 6

Leopard)

0S X 10.7.5 (Lion) (no Java) Apple’s Java 6
Oracle’s Java 8

0S X 10.8.5 (Mountain (no Java) Apple’s Java 6

Lion) Oracle’s Java 8

0S X 10.9 (Mavericks) (no Java) Apple’s Java 6

Oracle's Java 8

To find out which version of OS X you’re running, do the following:

1. Choose Apple~>About This Mac.
2. In the About This Mac dialog that appears, look for the word Version.
You see Version 10.9.2 (or something like that) in very light gray text.

The information in Table 2.1 applies to updated versions of Mac OS X. If you
don’t regularly apply software updates, you may be running OS X 10.8.1 instead
of 10.8.5. If so, select Software Update in the Apple menu and follow the result-
ing prompts.

Here and there on the web, | see postings describing ways to install Java 5.0 on
0OS X 10.3 and other ways to circumvent the restrictions in Table 2-1. But if you
don’t like to tinker, these workarounds aren’t for you. (For every hardware or
software requirement, someone tries to create a workaround, or hack. Anyway,
apply hacks at your own risk.)
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If you don’t trust Table 2-1 (and frankly, you shouldn’t trust everything you find
in print), you can perform tests on your computer to discover the presence
of Java and (if your Mac has Java) the Java version number. Here’s a test that
works on older versions of the Macintosh operating system:

1. In the Spotlight’s search field, type Java Preferences.

2. When the Spotlight’s Top Hit is Java Preferences, press Enter.

The Java Preferences window appears (see Figure 2-3).

8 .00 Java Preferences
Security Network Advanced |
|_ Enable applet plug-in and Web Start applications
Java applications, applets, and command line tools use this order to determine the first compatible version to
use.
On | Name Vendar CPU-Type Version
@j Java SE 7 Developer Preview Oracle Corpora... B4-bit 1.7.0-ea-b219
EI Java SE 7 Developer Preview Oracle Corpora... 32-hit 1.7.0-ea-b219
@ Java SE 6 (System) Apple Inc. 64-bit 1.6.0_29-b11-402
EI Java SE 6 (System) Apple Inc. 32-bit 1.6.0_29-b11-402
I
Figure 2-3:
Drag to change the preferred order
The Java
Options.. | Restore Defaults |
Preferences S
application.
Changes take effect in browsers and Java applications the next time you open them.
I

3. The Java Preferences window lists versions of Java that are installed
on your computer.

In Figure 2-3, the computer has four versions of Java — the 32-bit (i386)
versions of Java 6 and Java 7 and the 64-bit (x86_64) versions of Java 6
and Java 7.

For newer versions of the Macintosh operating system, try this test:

1. In the Apple menu, select System Preferences.

2. In the System Preferences application window, look for a Java icon
(see Figure 2-4).

3. Click the Java icon.

The Java Control Panel appears (see Figure 2-5).
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anon System Preferences
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General Desktop & Dock Mission Language Security Spotlight  Notifications
Screen Saver Contral & Region & Privacy
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CDs & DVDs Displays Energy Keyboard Mouse Trackpad Printers & Sound
Saver Scanners
iCloud Internet Network Bluetooth Sharing
Accounts
— 0 N 71N =
R »» @ & ¢ )
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Figure 2-4: S o
Users & Parental App Store Dictation  Date & Time Startup Time Accessibility
A Java Groups Controls & Speech Disk Machine
iconin the
System ¢
Preferences L=
application. Flash Player Java
|
Java Control Panel
Update | Java | Security = Advanced |
About
View version information about Java Control Panel.
| About... |
MNetwork Settings
Network settings are used when making Internet connections. By default, Java
will use the network settings in your web browser. Only advanced users should
modify these settings.
| Metwork Settings... |
Temporary Internet Files
Files you use in Java applications are stored in a special folder for quick
execution later. Only advanced users should delete files or modify these
settings.
| settings... | | Wiew...
Java in the browser is enabled.  See the Security tab
|
Figure 2-5:
The Java
Control
Panel. | ok | | cancel | Apply
|
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|
Figure 2-6:
The Java
tab in the
Java Control
Panel.
|

|
Figure 2-7:
The User
tabin

the Java
Runtime
Environment
Settings
window.
|

4. In the Java Control Panel, select the Java tab (see Figure 2-6).

8006

applets.

Java Control Panel
Update m Security = Advanced |
View and manage Java Runtime versions and settings for Java applications and
| View... |
[ ok | | cancel | Apply

| General

5. In the Java tab, click View.

The Java Runtime Environment Settings window appears (see Figure 2-7).

800 Java Runtime Environment Settings
I system |
Platform Product Location Path Runtime Parameters
1.8 1.8.0 http://java.s... [/Library/Internet Plu..]

[ oK J | Cancel |
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6. Look for versions of Java in the User tab and the System tab of the
Java Runtime Environment Settings window.

Figure 2-7 shows the User tab of the Java Runtime Environment Settings
window. According to the figure, the computer runs Java 1.8. (Java’s
close friends call this version “Java 8.”)

On Linux

To check your Java installation (or your lack of Java) on a Linux computer, do
the following:

1. Poke around among the desktop’s menus for something named Terminal
(also known as Konsole).

A Terminal window opens (usually with plain white text on a plain black
background).

2. In the Terminal window, type the following text and then press Enter:
java -version.

On my Linux computer, the Terminal window responds with the follow-
ing text:

java version 1.8.0_1

If your computer responds with the number 1.8.0 or higher, you can pop
open the champagne and look forward to some good times running this
book’s examples. If the version number is 1.5 or greater, you can run many,
but not all, of this book’s examples. If your computer responds with some-
thing like command not found, most likely, Java isn’t installed on your
computer.

Setting Up the Eclipse Integrated
Development Environment

In the previous sections, you get all the tools your computer needs for pro-
cessing Java programs. This section is different. In this section, you get the
tool that you need for composing and testing your Java programs. You get
Eclipse — an integrated development environment for Java.

An integrated development environment (IDE) is a program that provides tools
to help you create software easily and efficiently. You can create Java pro-
grams without an IDE, but the time and effort you save using an IDE makes
the IDE worthwhile. (Some hard-core programmers disagree with me, but
that’s another matter.)
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According to the Eclipse Foundation’s website, Eclipse is “a universal tool plat-
form — an open extensible IDE for anything and nothing in particular.” Indeed,
Eclipse is versatile. Programmers generally think of Eclipse as an IDE for
developing Java programs, but Eclipse has tools for programming in C++, PHP,
and many other languages. I've even seen incarnations of Eclipse that have
nothing to do with program development. (One such product is the Lively
Browser — a web browser whose tabs are built from Eclipse components.)

Downloading Eclipse

Here’s how you download Eclipse:

1. Visit www.eclipse.org.
2. Look for a way to download Eclipse for your operating system.

Today, I visit www.eclipse.org and see a big button displaying the
words Get Started Now . . . Download Eclipse (see Figure 2-8). Tomorrow,
who knows what I'll see on this ever-changing website!

After clicking the Download Eclipse button, [ see a list of downloads for
my computer’s operating system (see Figure 2-9).

<P Eclipse’s download page directs you to versions of Eclipse that are specific
to your computer’s operating system. For example, if you visit the page on
a Windows computer, the page shows you downloads for Windows only:. If
you're downloading Eclipse for use on another computer, you may want to
override the automatic choice of operating system. Look for a little drop-
down list containing the name of your computer’s operating system. You
can change the selected operating system in that drop-down list.

D

Home Downloads  Users  Members Committers  Resources  Projects  About Us

Figure 2-8:
The home

page for Add yourself to the .
eclipse.org. Download Ecllpse{b

Eclipse ;< year timeline

Eiuke 18k

3. Choose an Eclipse package from the available packages.

Regardless of your operating system, Eclipse comes in many shapes, sizes,
and colors. The Eclipse website offers Eclipse IDE for Java Developers,
Eclipse IDE for Java EE Developers, Eclipse Classic, and many other spe-
cialized downloads (see Figure 2-9).  usually select Eclipse IDE for Java
Developers, and | recommend that you do the same.
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= Dowvnioacied 1,354,339 Times Details Windows 4 Bit Software User Agreement unless
otherwise specified

. Eclipse Classic 3.7.1,172 8 Windows 32 Bit

Downloaded 1,047,857 Times  Details Other Downloads Windows 64 Bit
CRYSTAL REPORTS'

4. Choose between Eclipse’s 32-bit and 64-bit versions.

If you know which Java version you have (32-bit or 64-bit), be sure to
download the corresponding Eclipse version. If you don’t know which

Java version you have, download the 64-bit version of Eclipse and try to
launch it. If you can launch 64-bit Eclipse, you're okay. But if you get a No
Java virtual machine was found error message, try downloading

and launching the 32-bit version of Eclipse.

For the full lowdown on 32-bit and 64-bit word lengths, see this chapter’s

“How many bits does your computer have?” sidebar.
5. Follow the appropriate links to get the download to begin.

The links you follow depend on which of Eclipse’s many mirror sites is
offering up your download. Just wade through the possibilities and get
the download going.

Installing Eclipse

Precisely how you install Eclipse depends on your operating system and on

what kind of file you get when you download Eclipse. Here’s a brief summary:

v If you run Windows and the download is an . exe file:
Double-click the . exe file’s icon.
v+ If you run Windows and the download is a. zip file:

Extract the file’s contents to the directory of your choice.

In other words, find the . zip file’s icon in Windows Explorer (also known

as File Explorer). Then double-click the . zip file’s icon. (As a result,
Explorer displays the contents of the . zip file, which consists of only
one folder — a folder named eclipse.) Drag the eclipse folder to a
convenient place in your computer’s hard drive.
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For more information about . zip files, see the “Compressed archive
files” sidebar in this chapter.

My favorite place to drag the eclipse folder is directly onto the C: drive.
So my C: drive has folders named Program Files, Windows, eclipse,
and others. | avoid making the eclipse folder be a subfolder of Program
Files because from time to time, I've had problems dealing with the
blank space in the name Program Files.

v+ If you run Mac OS X:
When you download Eclipse, you get either a . tar.gz file or a . dmg file.

* A .tar.gzfile is a compressed archive file. When you download the
file, your web browser might automatically do some uncompressing
for you. If so, you won't find a . tar.gz file in your Downloads folder.
Instead, you'll find either a . tar file (because your web browser
uncompressed the .gz part) or an eclipse folder (because your
web browser uncompressed both the . tar and . gz parts).

If you find a new . tar file or . tar.gz file in your Downloads folder,
double-click the file until you see the eclipse folder. Drag this new
eclipse folder to your Applications folder, and you're all set.

¢ If you download a . dmg file, your web browser may open the file
for you. If not, find the . dmg file in your Downloads folder and
double-click the file. Follow any instructions that appear after
this double-click. If you're expected to drag Eclipse into your
Applications folder, do so.

v+~ If you run Linux:

You may get a . tar.gz file, but there’s a chance you’ll get a self-extracting
.binfile. Extract the . tar.gz file to your favorite directory or execute
the self-extracting .bin file.

Running Eclipse for the first time

The first time you launch Eclipse, you perform a few extra steps. To get
Eclipse running, do the following:

1. Launch Eclipse.

In Windows, the Start menu may not have an Eclipse icon. In that case,
look in Windows Explorer (aka File Explorer) for the folder containing your
extracted Eclipse files. Double-click the icon representing the eclipse.
exe file. (If you see an eclipse file but not an eclipse. exe file, check
this chapter’s “Those pesky filename extensions” sidebar.)
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Figure 2-10:
Eclipse’s
Workspace
Launcher.
|

On a Mac, go to the Spotlight and type Eclipse in the search field. When
Eclipse appears as the Top Hit in the Spotlight’s list, press Enter.

The first time you try to run Eclipse on a Mac, you might get a message
telling you that Eclipse isn’t from the App Store and isn’t from an identi-
fied developer. Nothing in this world is 100% safe, but I've downloaded
and installed Eclipse a zillion times, and I've never had a problem with it.
So to get around this stumbling block, find the Eclipse app entry in your
Applications folder (or wherever else you installed Eclipse). Control-click
the application entry and, in the resulting context menu, select Open. At
this point, a dialog box appears. The dialog box asks you if you're sure
that you want to open the application. You're sure, so click Open.

When you launch Eclipse, you see a Workspace Launcher dialog (see
Figure 2-10). The dialog asks where, on your computer’s hard drive, you
want to store the code that you will create using Eclipse.

« Workspace Launcher ==

Select a workspace

Eclipse stores your projects in a folder called a workspace
Choose a workspace folder 1o use for this session.

Workspace:  C\Wsers\bburdvwrarkspace -

Use thig as the default and do not ask again

0K !}J | Cancel

2. In the Workspace Launcher dialog, click OK to accept the default (or

don’t accept the default!).
One way or another, it’s no big deal!

Because this is your first time using a particular Eclipse workspace, Eclipse
starts with a Welcome screen (see Figure 2-11). Through the ages, most of
the Eclipse Welcome screens have displayed icons along with little or no
helpful text.

. Hover over the icons on Eclipse’s Welcome screen until you find an
icon whose tooltip contains the word Workbench.

. Click the Workbench icon to open Eclipse’s main screen.

A view of the main screen, after opening Eclipse with a brand-new work-
space, is shown in Figure 2-12.
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Figure 2-13:
Eclipse’s
Preferences
dialog.
|

Configuring Java in Eclipse

Eclipse normally looks on your computer for Java installations and selects an
installed version of Java to use for running your Java programs. Your computer
may have more than one version of Java, so you may want to double-check
Eclipse’s choice of the Java version. The following steps show you how:

1. On Windows or Linux: In Eclipse’s main menu, select Windowr>
Preferences. On a Mac: In Eclipse’s main menu, select Eclipse~>
Preferences.

As aresult, Eclipse’s Preferences dialog appears. (You can follow along
with Figure 2-13.)

e Preferences - B
type filker text Installed JREs ProTw
General . - 5 A
Add, rernowe or edit IRE definitions. By default, the checked IRE is added to the build path

Ant of newly created lava projects.

Code Recommenders

Help Installed JREs:

Install/Updat

nstalLipdate Mame Location Type Add...

4 Java

Appearance [] =hjdk16.0 32 Ch\Program FileshJava'jdk1.6.0_32 Stan Edit.
Build Path [] =hjdk1.7.0.25 Ct\Program Files (@6 avaljdk1.7.0 25 Stan
Code Style Ehjdk1.8.0 (d.. C:\Program FilesiJavaljdk1.8.0 Stan| Duplicate..
Compiler Remawe
Debug
Editar Search..
Installed IREs
JUnit %
Properties Files Editor

Maven

Pelyn

Run/Debug

Team

Walidation

WindowBuilder

HML < >

=

2. In the tree on the left side of the Preferences dialog, expand the Java
branch.

. Within the Java branch, select the Installed JREs sub-branch.

w

4. Look at the list of Java versions (Installed JREs) in the main body of
the Preferences dialog.

In the list, each version of Java has a check box. Eclipse uses the version
whose box is checked. If the checked version isn’t your preferred version
(for example, if the checked version isn’t version 8 or higher), you can
make some changes.



|
Figure 2-14:
The JRE
Type dialog.
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5. If your preferred version of Java appears in the Installed JREs list, put

a check mark in that version’s check box.

6. If your preferred version of Java doesn’t appear in the Installed JREs

list, click the Add button.

When you click the Add button, a JRE Type dialog appears (see Figure 2-14).

 Add JRE )

JRE Type 2
Select the type of JRE to add to the workspace Ek;

Installed JRE Types:

Execution Environment Description
Standard 1.1.3 Vi
Standard WM

7. In the JRE Type dialog, double-click Standard VM.

As aresult, a JRE Definition dialog appears (see Figure 2-15). What you do

next depends on a few different things.

8. Fill in the dialog’s JRE Home field.

How you do this depends on your operating system.

e On Windows, browse to the directory in which you've installed
your preferred Java version. On my many Windows computers,
that directory is either C: \Program Files\Java\jre8, C:\

Program Files\Java\jdk1l.8.0,C:\Program Files

Java\jre8, or something of that sort.

(x86)\

¢ On a Mac, use the Finder to browse to the directory in which
you've installed your preferred Java version. Type the name of the

directory in the dialog’s JRE Home field.

My Mac has one Java directory named /System/Library/
Java/Java Virtual Machines/1.6.0.jdk/Contents/

Home and another Java directory named /Library/Java/

JavaVirtualMachines/jdk 1.8.0.7jdk/Contents/Home.
(The first is for Apple’s old version of Java; the second is for
Oracle’s new Java version.) You might also find Oracle’s Java in
the /Library/Internet Plug-Ins/JavaAppletPlugin.

plugin/Contents/Home directory

b5
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S Add JRE e - o IEH]
JRE Definition )\
Specify attributes for a JRE %\')
JRE home: Ci\Program Files\Javaijdk1.8.0 Directony...
JRE name: jdk1.8.0
Default VM arguments: Watiables...

JRE systern libraries:

4 CAProgram FilesyJavalydk1.8.0yretlib\resources jar A | Add External JARs...
- @ CAProgram Files\Jawvaydk1.8.0redlibhrt jar :
9 CAProgram FilesYavalydk1.8.0yretlibyjsse jar Javadoc Location

- 9 CAProgram Filesh)avayjdk1.8.0yre\libyjce jar
e CAProgram Files\avayjdk1.8.0yrevlib\charsets jar

Source Attachment

9 CAProgram Files\)awvayjdk1.8,0yre\lib\jfr.jar Rermowe
as CAProgram FileshJava'ydk1.8.0yrelibhext\access-bridge-
I + lwa CAProgram Files\Javayjdk1.8.0\re\libhext\cldrdata.jar U
Figure 2-15: o CAProgram Fileshavaydk1.8.0yretlibhext\dnsns jar -
> m.:, CAProgram Files\Javaljdk1.8.0redlibhext\jaccess jar v —
DT?e ‘tJRE < > Restore Default
efinition
dialog (after
you've fol-
lowed Steps .
8 and 9) '\?j < Back ext Finish L\s Cancel
|
P Directories like /System and /Library don’t normally appear in
the Finder window. To browse to one of these directories (to the
/Library directory, for example), choose Go>Go to Folder in the
Finder’s menu bar. In the resulting dialog, type /Library and then
press Go.
P As you navigate to the directory containing your preferred Java

version, you may encounter a JDK 1.8.0.jdk icon or some other
item whose extension is . jdk. To see the contents of this item,
control-click the item'’s icon and then select Show Package Contents.

¢ On Linux, browse to the directory in which you’ve installed your
preferred Java version. When in doubt, search for a directory
whose name starts with jre or jdk.

You might have one more thing to do back in the JRE Definition dialog.

9. Look at the JRE Definition dialog’s JRE Name field; if Eclipse hasn’t
filled in a name automatically, type a name (almost any text) in the
JRE Name field.

10. Dismiss the JRE Definition dialog by clicking Finish.

Eclipse’s Preferences dialog returns to the foreground. The box’s Installed
JRE:s list contains your newly added version of Java.



Figure 2-16:
Setting the
compiler
compliance
level.
|

of Java.
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11. Put a check mark in the check box next to your newly added version

You’re almost done. (You have a few more steps to follow.)

select the Compiler sub-branch.

12. Within the Java branch on the left side of the Preferences dialog,

In the main body of the Preferences dialog, you see a Compiler Com-
pliance Level drop-down list (see Figure 2-16).

type filter text

. General

» Ant

» Code Recommenders
Help

- Install/Update

lava

[

- Bppearance
- Build Path
- Code Style
- Compiler
- Debug
- Editor
Installed JREs
IUnit
Properties Files Editor
: Maven
Mylyn
- Run/Debug
- Team
Walidation
- WindowBuilder
- XML

Preferences

Compiler

JDK Compliance

Configure Project Specific Settings..,

Cornpiler corpliance lewvel:

Use default compliance settings

Classfile Generation

[¥] Add variable attributes to generated class files (used by the debugger)
[#] Add line nurnber attributes to generated class files (used by the debugger)

16

1.3
14
1.5
1.6
1.7

Error

[¥] Add source file narme to generated class file (used by the debugger)

[#] Preserve unused (never read) local variables

#|Inline finally blocks {larger class files, but improved performance)

Store method parameter names {usable via reflection)

I, When selecting 1.6 cornpliance, make sure to have a corpatible JRE installed and

activated (currenthy 1.8). Configure..,

Restare Defaults

Apply

Cancel

that matches your preferred Java version.

13. In the Compiler Compliance Level drop-down list, select a number

For Java 7, I select compliance level 1.7. For Java 8, I select compliance

level 1.8.

Eclipse workbench.

14. Whew! Click the Preferences dialog’s OK button to return to the
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Importing this book’s sample programs

This import business can be tricky. As you move from one dialog to the next,
many of the options have similar names. That’s because Eclipse offers many
different ways to import many different kinds of things. Anyway, if you follow
these instructions, you’ll be okay.

1. Follow the steps in this chapter’s earlier “Getting This Book’s Sample
Programs” section.
2. In Eclipse’s main menu, choose File>Import (see Figure 2-17).

As a result, Eclipse displays an Import dialog.

= Java - Eclipse
Edit Run Source Mawvigate Search Project Refactor W
Mews Alt+Shift+M » %3\‘ - Q-
Open File..,
Close Chrl +4f
Close All Cirl+Shift -+
Save Cirl+5
Save As...
Save &l Ctrl+Shift+3
Rewvert
Move..,
Renarme... F2
2] Refresh F5
Corwert Line Delimiters To 3
Print.. Ctrl+P
Switch Workspace 3
Restart
iy Import.,
[0 p
Ak L&
Ly Export.
— Froperties Alt+Enter
Figure 2-17: Exit
Starting to ™
import this
book’s code. -
5t Problems &2 @
|

3. In the Import dialog’s tree, expand the General branch.

4. In the General branch, double-click the Existing Projects into Workspace
sub-branch (see Figure 2-18).

As aresult, an Import Projects dialog appears.
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= Import [E=Een )
Select \
Create new projects from an archive file or directory. @

Select an import source:

type filter text

a [= General
E Archive File
= Existing Projects into ¥orkspace
[, File System
L Preferences
> = CVE
> = Git
> = Install
I > & Maven
. > = Run/Debug
Figure 2-18: . (= Tasks
Among all : Z;:'[”
the options,
select
Existing
Projects into
Workspace. || @ < Back Finish
|
5. In the Import Projects dialog, choose either the Select Root Directory
radio button or the Select Archive File radio button (see Figure 2-19).
Here’s how you decide which radio box to choose:
First, make sure that you've heeded the advice that I give in the sidebar
entitled “Those pesky filename extensions.” Then look in the folder con-
taining the file that you downloaded from this book’s website.

e If your web browser doesn’t automatically uncompress down-
loaded . zip files, you'll find this book’s code in an archive file
named BeginProgJavaDummies4 . zip. In that case, choose the
Select Archive File radio button.

e If your web browser automatically uncompresses downloaded . zip
files, you'll find this book’s code in a directory (a folder) named
BeginProgJdavaDummies4. In that case, choose the Select Root

Q‘&N\BER Directory radio button.
Q

To ensure that you can distinguish between a folder and a . zip file, check
this chapter’s “Those pesky filename extensions” sidebar.

For the complete scoop on . zip files and other archive files, the sidebar
entitled “Compressed archive files.”

6. Click the Browse button to find the BeginProgJavaDummies4 .zip file
or the BeginProgDummies4 directory on your computer’s hard drive.

After you find the file or the directory, Eclipse’s Import Projects dialog displays the
names of the projects inside the file. (Again, refer to Figure 2-19.)
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<= Import [ESEESE=x==)
Import Projects r
Select a directory to search for existing Eclipse projects 4
-
() Select root directory Browse

@ Select archive file:

Projects

Chlzers\bburd\Downloads\BeginProgJavaDummies3.zip

Browse..

03-01 [03-07)
9] 04-01 (04-01)
501 (05-01)
0E-01 (0-07)
0E-02 (06-02)
07-01 (07-07)
07-02 (07-02)

[N R L

»

Select Al
L

Deselect All

m

Copy projects into workspace

7. Click the Select All button.

This book’s examples are so exciting that you want to import all of them!
8. Click the Finish button.

As a result, the main Eclipse workbench reappears. The left side of
the workbench displays the names of this book’s Java projects (see
Figure 2-20).

Now the real fun begins.

= Java - Eclipse —
File Edit Run Source Navigate Search
Bvm B &,
[ Package Explorer 52 =8
&le~

- les O
Figure 2-20: | » = 0501
H > == 06-01
I_Ecllpse ) 2 06502
displays | » & or-m
» & 07-02
abunch | "= o
of Java | . oam
projects. | © 0502
- v 08-03

J oo
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What's Next?

If you're reading this paragraph, you’'ve probably followed some of the
instructions in this chapter — instructions for installing Java and the Eclipse
IDE on your computer. So the burning question is this: Have you done the
installation correctly? The answer to that question lies in Chapter 3 because
in that chapter, you use these tools to run a brand-new Java program.
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Chapter 3
Running Programs

In This Chapter
Compiling and running a program
Working with a workspace
Editing your own Java code

’ f you're a programming newbie, for you, running a program probably means
clicking a mouse. You want to run Internet Explorer, so you double-click the
Internet Explorer icon. That’s all there is to it.

When you create your own programs, the situation is a bit different. With a
new program, the programmer (or someone from the programmer’s company)
creates the program’s icon. Before that process, a perfectly good program may
not have an icon at all. So what do you do with a brand-new Java program?
How do you get the program to run? This chapter tells you what you need

to know.

Running a Canned Java Program

The best way to get to know Java is to do Java. When you’re doing Java, you're
writing, testing, and running your own Java programs. This section prepares
you by describing how you run and test a program. Instead of writing your
own program, you run a program that I've already written for you. The pro-
gram calculates your monthly payments on a home mortgage loan.

The mortgage-calculating program doesn’t open its own window. Instead, the
program runs in Eclipse’s Console view. The Console view is one of the tabs
in the lower-right part of the Eclipse workbench (see Figure 3-1). A program
that operates completely in this Console view is called a text-based program.
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|
Figure 3-1:
A run of this
chapter's
text-based
mortgage
program.
|

a\\J

L «POITTC] AOW TUCTT ar e YOu OO T OWITTEY
21 prlnclpal = Double.parsefouble(keyboard. nesctline() ) ;

1% Problems | @ Javadoc |[&, Declaration |47 Search | Bl Consale 52
<terminated= Maortgage [Java Application] C:\Program Files\Javayjre?bintja

ackage)
ag.e.Java . How much are you borrowing? laeaaa. ea
Library [Java® What's the interest rate? 5.25

How many years are you taking to pay? 3@

Your monthly payment is $552.2@

You may not see a Console tab in the lower-right part of the Eclipse workbench.
To coax the Console view out of hiding, choose Window=>Show Viewr>Other. In
the resulting Show View dialog box, expand the General branch. Finally, within
that General branch, double-click the Console item.

For more information about the Console view (and about Eclipse’s workbench
in general), see the “Views, editors, and other stuff” section, later in this
chapter.

You can see GUI versions of the program in Figure 3-1, and of many other
examples from this book, by visiting the book’s website (allmycode.com/
BeginProg).

Actually, as you run the mortgage program, you see two things in Eclipse’s
Console view:

1 Messages and results that the mortgage program sends to you: Messages
include things like How much are you borrowing?.Results include
lines like Your monthly payment is $552.20.

1 Responses that you give to the mortgage program while it runs: If you
type 100000.00 in response to the program’s question about how much
you’re borrowing, you see that number echoed in Eclipse’s Console view.

Here’s how you run the mortgage program:

1. Make sure that you’'ve followed the instructions in Chapter 2 — instruc-
tions for installing Java, for installing and configuring Eclipse, and for
getting this book’s sample programs.

Thank goodness! You don’t have to follow those instructions more
than once.

2. Launch Eclipse.
The Eclipse Workspace Launcher dialog box appears (see Figure 3-2).


http://allmycode.com/beginprog
http://allmycode.com/beginprog
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|
Figure 3-2:
The Eclipse
Workspace
Launcher.
|

= Workspace Launcher [E=x=)

Select a workspace

| . .
Eclipse stores your projects in a folder called a workspace
Choose a workspace folder to use for this session

Warkspace: C:\Usersibburdworkspace - Browse...

[1Use this as the default and do not ask again

[ oK N H Cancel

A workspace is a folder on your computer’s hard drive. Eclipse stores your
Java programs in one or more workspace folders. Along with these Java
programs, each workspace folder contains some Eclipse settings. These
settings store things like the version of Java that you're using, the colors
that you prefer for words in the editor, the size of the editor area when
you drag the area’s edges, and other things. You can have several work-
spaces with different programs and different settings in each workspace.

By default, the Workspace Launcher offers to open whatever workspace
you opened the last time you ran Eclipse. You want to open the workspace
that you used in Chapter 2, so don’t modify the stuff in the Launcher’s
Workspace field.

. In the Workspace Launcher dialog box, click OK.

The big Eclipse workbench stares at you from your computer screen
(see Figure 3-3).

In Figure 3-3, the leftmost part of the workbench is Eclipse’s Package
Explorer, which contains numbers like 03-01, 04-01, and so on. Each
number is actually the name of an Eclipse project. Formally, a project is
a collection of files and folders inside a workspace. Intuitively, a project
is a basic work unit. For example, a self-contained collection of Java pro-
gram files to manage your CD collection (along with the files containing
the data) may constitute a single Eclipse project.

Looking again at the Package Explorer in Figure 3-3, you see projects
named 03-01, 04-01, and so on. My project 03-01 holds the first and
only example in Chapter 3 (this chapter). Project 06-02 contains the
Java program in Listing 6-2 (the second code listing in Chapter 6 of
this book). Project names can include letters, digits, blank spaces, and
other characters, but for the names of this book’s examples, I stick
with digits and dashes.

To read more about things like Eclipse’s Package Explorer, see the upcom-
ing section “What’s All That Stuff in Eclipse’s Window?”
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Figure 3-3:
The Eclipse
workbench.
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When you launch Eclipse, you may see something different from the stuff
in Figure 3-3. You may see Eclipse’s Welcome screen with only a few icons
in an otherwise barren window. You may also see a workbench like the
one in Figure 3-3, but without a list of numbers (03-01, 04-01, and so on)
in the Package Explorer. If so, you may have missed some instructions

on configuring Eclipse in Chapter 2. Alternatively, you may have modi-
fied the stuff in the Launcher’s Workspace field in Step 2 of this section’s
instructions.

In any case, make sure that you see numbers like 03-01 and 04-01 in the
Package Explorer. Seeing these numbers assures you that Eclipse is
ready to run the sample programs from this book.

. In the Package Explorer, click the 03 -01 branch.

This chapter’s Java project — the 03-01 project — appears highlighted.

You may want to see a sneak preview of some Java code. To see the Java
program that you’re running in Project 03-01, expand the 03-01
branch in the Package Explorer. Inside the 03-01 branch, you find a

src branch, which in turn contains a (default package) branch.
Inside the (default package) branch, you find the Mortgage.java
branch. That Mortgage . java branch represents my Java program.
Double-clicking the Mortgage . java branch makes my code appear in
Eclipse’s editor.
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|
Figure 3-4:
One of the
ways to run
the code in
Project
03-01.
|
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5.

Choose Run~Run As~>Java Application from the main menu, as
shown in Figure 3-4.

When you choose Run Asc>Java Application, the computer runs the
project’s code. (In this example, the computer runs a Java program
that I wrote.) As part of the run, the message How much are you
borrowing? appears in Eclipse’s Console view. (The Console view
shares the lower-right area of Eclipse’s workbench with the Problems
view, the Javadoc view, the Declaration view, and possibly other views.
Refer to Figure 3-1.)

= Java - Eclipse -

File EdltSource Mavigate Search Project Refactor “Window Help

[ Packa Run History 3

=@, Run Col+Fll @ v @ &~ @& @S v
%, Debug Fi1

Run & ¥ | B 1lava Applet Alt+Shift+X, &
. bj 03 Run Canfigurations... G 2lava Application p AltaShiftX,
lbd 04 Debug History > I
6. Click anywhere inside Eclipse’s Console view and then type a number,

like 100000.00, and press Enter.

When you type a number in Step 6, don’t include your country’s currency
symbol and don’t group the digits. (U.S. residents, don’t type a dollar
sign and don’t use any commas.) Things like $100000.00 and 1,000,000.00
cause the program to crash. You see a NumberFormatException mes-
sage in the Console view.

Grouping separators vary from one country to another. The run shown
in Figure 3-1 is for a computer configured in the United States where
100000.00 (with a dot) means “one hundred thousand.” But the run
might look different on a computer that’s configured in what I call a
“comma country” — a country where 100000,00 (with a comma) means
“one hundred thousand.” If you live in a comma country, and you type
100000.00 exactly as it’s shown in Figure 3-1, you probably get an error
message (an InputMismatchException). If so, change the number
amounts in your file to match your country’s number format. When you
do, you should be okay.

After you press Enter, the Java program displays another message
(What's the interest rate?) inthe Console view. (Again, refer
to Figure 3-1.)

. In response to the interest rate question, type a number, like 5.25, and

press Enter.

After you press Enter, the Java program displays another message (How
many years . . . ?)inthe Console view.
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8. Type a number, like 30, and press Enter.

In response to the numbers that you type, the Java program displays a
monthly payment amount. Again, refer to Figure 3-1.

Disclaimer: Your local mortgage company charges fees of all kinds. To
get a mortgage in real life, you pay more than the amount that my Java
program calculates. (A lot more.)

JWNG/

&VQ‘ When you type a number in Step 8, don’t include a decimal point. Numbers
like 30.0 cause the program to crash. You see a NumberFormatException
message in the Console view.

Occasionally, you decide in the middle of a program’s run that you’'ve
A\ made a mistake of some kind. You want to stop the program’s run dead
in its tracks. Simply click the little red rectangle above the Console view
(see Figure 3-5).
|
Figure 3-5: . ~b
How to % Prablems | @ Javadoc | &, Declaration |4 Search | El Console 22 | ®
prematurely Martgage [lava Application] C:\Program Fileshlavayjre?bin\javaw exe (Dec 4, 20%;?1)
terminate a —
prOgram’S How much are wou borrowing?
run.
|

If you follow this section’s instructions and you don’t get the results that I
describe, you can try three things. I list them in order from best to worst:

v Check all the steps to make sure that you did everything correctly.

v Send an e-mail to me at BeginProg@allmycode.com, post to my
Facebook wall (/allmycode), or tweet to the Burd (@allmycode). If
you describe what happened, I can probably figure out what went wrong
and tell you how to correct the problem.

v Panic.

Typing and Running Your Own Code

The previous section is about running someone else’s Java code (code that
you download from this book’s website). But eventually, you’ll write code on
your own. This section shows you how to create code with the Eclipse IDE.
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|
Figure 3-6:
Switching to
a different
Eclipse
workspace.
|

Separating your programs from mine

In Chapter 2, you download this book’s examples from my website. Then
you create an Eclipse workspace and import the book’s examples into your
workspace.

You can create your own projects in the same workspace. But if you want to
separate your code from mine, you can create a second workspace. Here are
two ways to create a new workspace:

+* When you launch Eclipse, type a new folder name in the Workspace
field of Eclipse’s Workspace Launcher dialog box.

If the folder doesn’t already exist, Eclipse creates the folder. If the folder
already exists, Eclipse’s Package Explorer lists any projects that the
folder contains.

+” In the Eclipse workbench’s main menu, choose File->Switch Workspace
(see Figure 3-6).

When you choose Filem>Switch Workspace, Eclipse offers you a few

of your previously opened workspace folders. If your choice of folder
isn’t in the list, select the Other option. In response, Eclipse reopens its
Workspace Launcher dialog box.

= Java - Ecllpse
Edit Bun  Mavigate Search Project Refactor Window Help

Mewr Aeeshiftelr | @« @ e o
Open File..,

Close Carl+4
Close &l Ctel+Shift+4

Save Cirl+5
Save As..,

Save Al Ctrl +Shift+5
Rewvert

kowe..,
Rename... F2
Refresh F3

Corrvert Line Delimiters Ta 3

Print... Ctri+P

Switch Warkspace 3 hpurgelurark
Restart hwsersibburdiorkspace

fxg Import., chpurgetivorkspacelaval

£ Export.. chpurgetivorkspacelaval

Properties Alt+Enter Ot LT

1 Mortgage java [03-01fsrc]
2 MyFirstlavaClassjava [_pasted_code..]
3 MyFirstlavaClassjava [Users/bburdf.. ]

Exit:
=R A =T
& 1202
& 1203 -

59



60 Part I: Getting Started with Java Programming

Writing and running your program

Here’s how you create a new Java project:

1. Launch Eclipse.
2. From Eclipse’s menu bar, choose Filem> Newr>Java Project.
A New Java Project dialog box appears.

3. In the New Java Project dialog box, type a name for your project and
then click Finish.

s&mBEn In Figure 3-7, I type the name MyFirstProject.
& . . . .
« If you click Next instead